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Paper Set 1 · 28 Jun 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
16 cm ଉଚ୍ଚତା ଏବଂ 3 cm ଭୂ ମି  ବ୍ୟାସାର୍ଦ୍ଧ  ବି ଶି ଷ୍ଟ ଏକ ସରଳ ବୃ ତ୍ତଭୂ ମି କ ସି ଲି ଣ୍ଡରର
ଆୟତନ କେତେ?

A.  144π cm3

B.  48π cm3

C.  192π cm3

D.  108π cm3

✓

Q2 Quant
A ଗୋଟି ଏ କାର୍ଯ୍ୟ କୁ  8 ଦି ନରେ ଶେଷ କରି ପାରି ବ ଏବଂ B ସମାନ କାର୍ଯ୍ୟ କୁ  10 ଦି ନରେ
କରି ପାରି ବ । ଯଦି  ସେମାନେ ଏକାଠି  କାମ କରନ୍ତି , ତେବେ କାର୍ଯ୍ୟ ଟି  ଶେଷ କରି ବାକୁ
ସେମାନେ କେତେ ସମୟ ନେବେ?
(ଦଶମି କ 2 ଟି  ସ୍ଥାନ ପର୍ଯ୍ୟ ନ୍ତ ପୂ ର୍ଣ୍ଣା ଙ୍କି ତ କରନ୍ତୁ)

A.  5.25 ଦି ନ

B.  4.44 ଦି ନ

C.  4.25 ଦି ନ

D.  3.87 ଦି ନ

✓

Q3 Quant
ଅଖି ଳ ₹850 ରେ ଏକ ତକି ଆ କି ଣି  20% ଲାଭରେ ସୋହି ଲଙ୍କୁ  ବି କ୍ରି   କଲେ । ପରେ,
ସୋହି ଲ ଏହାକୁ  30% କ୍ଷତି ରେ ରବି ଙ୍କୁ  ବି କ୍ରି   କଲେ । ଅଖି ଳ ଏବଂ ରବି ଙ୍କ କ୍ର ୟ ମୂ ଲ୍ୟ
ମଧ୍ୟରେ ପାର୍ଥ କ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  ₹116

B.  ₹126

C.  ₹130

D.  ₹136

✓

Q4 Quant
ଯେତେବେଳେ ଜଣେ ବ୍ୟକ୍ତି  S1 ଓ S2 ବେଗରେ ସମାନ ଦୂ ରତା ଅତି କ୍ର ମ କରନ୍ତି , ତାଙ୍କର
ହାରାହାରି  ବେଗ 4 km/hr ହୋଇଥାଏ, କି ନ୍ତୁ ଯେତେବେଳେ ସେ ସମାନ ସମୟ
ବ୍ୟବଧାନରେ ଏହି  ବେଗରେ ଯାତ୍ରା  କରନ୍ତି , ତାଙ୍କର ହାରାହାରି  ବେଗ 4.5 km/hr
ହୋଇଥାଏ । ବେଗ ମଧ୍ୟରେ ପାର୍ଥ କ୍ୟ କେତେ?

A.  3 km/hr

B.  4 km/hr

C.  5 km/hr

D.  4.5 km/hr

✓

Q5 Quant
P, Q ଓ R ଏକ ବ୍ୟବସାୟରେ 4 : 5 : 6 ଅନୁ ପାତରେ ନି ବେଶ କରନ୍ତି  । 12 ମାସ ପରେ
ସେମାନଙ୍କର ନି ବେଶ ଅନୁ ପାତ ଉପରେ ଆଧାର କରି  ସେମାନେ ₹33,000 ର ମୋଟ ଲାଭ
ବାଣ୍ଟି  ନି ଅନ୍ତି  । ମୋଟ ଲାଭରୁ  Q କେତେ ଲାଭ ପାଆନ୍ତି ?

A.  ₹9,500

B.  ₹10,000

C.  ₹10,500

D.  ₹11,000

✓

Q6 Quant
ସଲୋନି  ତାଙ୍କ କାରକୁ  ପ୍ର କୃ ତ ବେଗର ତି ନି -ଚତୁ ର୍ଥାଂ ଶ ବେଗରେ ଚଳାଉଛନ୍ତି  । ସେ 175
ମି ନି ଟରେ 105 km ଅତି କ୍ର ମ କରନ୍ତି  । କାରର ପ୍ର କୃ ତ ବେଗ କେତେ ?

A.  35 km/hr

B.  42 km/hr

C.  45 km/hr

D.  48 km/hr

✓

Q7 Quant
ଯଦି  x ଓ 9 ର ମଧ୍ୟ ସମାନୁ ପାତୀ 15 ହୁ ଏ, ତେବେ x ର ମୂ ଲ୍ୟ କେତେ?

A.  21

B.  25

C.  27

D.  30

✓

Q8 Quant
ନି ମ୍ନ ଲି ଖି ତ ସଂଖ୍ୟାଗୁ ଡି କର ସେଟର ମଧ୍ୟମା ନି ର୍ଣ୍ଣ ୟ କର: -1.5, 3.6, -2.5, -2.1, -1.6,
2.2, -3.5, 1.1

A.  1.5

B.  -1.5

C.  1.55

D.  -1.55

✓

Q9 Quant
ଯଦି  ଗୋଟି ଏ ସଂଖ୍ୟାର 20% କୁ  30 ସହି ତ ଯୋଗ କରାଯାଏ, ତେବେ ଫଳାଫଳ ସମାନ
ସଂଖ୍ୟା ହେବ । ସମାନ ସଂଖ୍ୟାର 80% କେତେ?

A.  30

B.  20

C.  60

D.  50
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✓

Q10 Quant
₹7490 କୁ  ଏପରି  ତି ନି  ଭାଗରେ ବି ଭକ୍ତ କରନ୍ତୁ ଯେପରି  ପ୍ର ଥମ ଭାଗର ଅଧା, ଦ୍ୱି ତୀୟ
ଭାଗର ଏକ-ଚତୁ ର୍ଥାଂ ଶ ଏବଂ ତୃ ତୀୟ ଭାଗର ଏକ-ଅଷ୍ଟମାଂଶ ପରସ୍ପର ସହ ସମାନ ହେବେ ।
ଦ୍ୱି ତୀୟ ଭାଗର ମୂ ଲ୍ୟ (₹ ରେ) କେତେ?

A.  2140

B.  2640

C.  3140

D.  3640

✓

Q11 Quant

1020.63 = x, 1020.94 = y ଏବଂ xz = y5 ପ୍ର ଦତ୍ତ ଥି ଲେ, z ର ମୂ ଲ୍ୟ ପାଖାପାଖି
___________ ହେବ ।

A.  7.46

B.  6.41

C.  9.71

D.  8.63

✓

Q12 Quant
ବାର୍ଷିକ 10% ସରଳ ସୁ ଧ ହାରରେ ₹1200 କୁ  ₹2700 ହେବା ପାଇଁ  କେତେ ସମୟ (ବର୍ଷ
ରେ) ଲାଗି ବ?

A.  12.5

B.  11.5

C.  13.5

D.  14.5

✓

Q13 Quant
ବରୁ ଣଙ୍କ ପାଖରେ ₹1,302 ଅଛି  । ସେ ଏହାକୁ  ତାଙ୍କ ପୁ ଅ ଆଶି ଷ ଓ ଅରୁ ଣଙ୍କ ମଧ୍ୟରେ ବାଣ୍ଟି
ଦେଲେ ଏବଂ ସେମାନଙ୍କୁ  ବାର୍ଷିକ 10% ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ହାରରେ ନି ବେଶ କରି ବାକୁ  କହି ଲେ
। ଦେଖାଗଲା ଯେ ଆଶି ଷ ଓ ଅରୁ ଣ ଯଥାକ୍ର ମେ 11 ଓ 12 ବର୍ଷ  ପରେ ସମାନ ପରି ମାଣର
ସମୂ ଳସୁ ଧ ପାଇଲେ । ବରୁ ଣ ଅରୁ ଣଙ୍କୁ  କେତେ ଟଙ୍କା (₹ ରେ) ଦେଇଥି ଲେ?

A.  620

B.  682

C.  470

D.  782

✓

Q14 Quant
ଏକ ବହିଃ ସ୍ଥ ବି ନ୍ଦୁ  P ରୁ  ଏକ ସ୍ପର୍ଶ କ PT, ଯେଉଁ ଠାରେ T ଏକ ସ୍ପର୍ଶ  ବି ନ୍ଦୁ  ଅଟେ, ଏବଂ ଏକ
ରେଖାଖଣ୍ଡ PAB କେନ୍ଦ୍ର O ବି ଶି ଷ୍ଟ ଏକ ବୃ ତ୍ତ ପ୍ର ତି  ଅଙ୍କନ କରାଯାଇଛି  । ଜ୍ୟା AB ପ୍ର ତି  OM
ଲମ୍ବ ଅଟେ । ଯଦି  PB = 34 cm, AM = 10 cm ହୁ ଏ, ତେବେ PT2 ର ମୂ ଲ୍ୟ (cm2 ରେ)
ନି ର୍ଣ୍ଣ ୟ କର ।

A.  576

B.  476

C.  625

D.  525

✓

Q15 Quant
ଏକ ତ୍ରି  ଭୁ ଜରେ ଦୁ ଇଟି  କୋଣ 45° ଏବଂ 55° ଅଟେ । ତ୍ରି  ଭୁ ଜର ତୃ ତୀୟ କୋଣ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  45°

B.  55°

C.  100°

D.  80°

✓

Q16 Quant
ଗୋଟି ଏ ସଂଖ୍ୟାକୁ  60% ବୃ ଦ୍ଧି  କଲେ 3870 ହୁ ଏ । ସଂଖ୍ୟାଟି  କେତେ?

A.  2418.75

B.  2837.52

C.  1209.37

D.  1756.25

✓

Q17 Quant
1394 ରେ କେଉଁ  ସଂଖ୍ୟାକୁ  ଯୋଗ କଲେ ଯୋଗଫଳ 37 ଦ୍ୱାରା ବି ଭାଜ୍ୟ ହେବ?

A.  25

B.  19

C.  12

D.  8

✓

Q18 Quant
ଜଣେ ଦୋକାନୀ 24 ଟି  କଲମକୁ  25% ଲାଭରେ ଏବଂ ଅନ୍ୟ 20 ଟି  କଲମକୁ  15%
ଲାଭରେ ବି କ୍ରି   କଲେ । ପ୍ର ତ୍ୟେକ କଲମର କ୍ର ୟ ମୂ ଲ୍ୟ ସମାନ ଅଟେ । ଯଦି  ସମସ୍ତ 44 ଟି
କଲମ 20% ଲାଭରେ ବି କ୍ରି   ହୋଇଥାନ୍ତା, ତେବେ ମୋଟ ଲାଭ ₹5.60 କମ୍  ହୋଇଥାନ୍ତା ।
ପ୍ର ତ୍ୟେକ କଲମର କ୍ର ୟ ମୂ ଲ୍ୟ କେତେ?

A.  ₹24

B.  ₹28

C.  ₹22

D.  ₹26

✓

Q19 Quant
A ଦୁ ଇଟି  ନି ର୍ଦ୍ଦିଷ୍ଟ ଷ୍ଟେସନ ମଧ୍ୟରେ 6 ଦି ନରେ ରେଳ ଟ୍ରା କ୍  ବି ଛାଇପାରି ବେ ଏବଂ B
ସମାନ କାମ 28 ଦି ନରେ କରି ପାରି ବେ । C ଙ୍କ ସାହାଯ୍ୟରେ ସେମାନେ 4 ଦି ନରେ କାମ
ସମ୍ପୂ ର୍ଣ୍ଣ  କରି ଥି ଲେ । ତେବେ ଏକାକୀ C ଏହି  କାମକୁ  କେତେ ଦି ନରେ କରି ପାରି ବେ?

A.  21

B.  22

C.  23

D.  24
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✓

Q20 Quant
ନି ମ୍ନ ଲି ଖି ତ ସମୀକରଣ ପ୍ର ଣାଳୀ ସମାଧାନ କର ଏବଂ z ର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।​x + y + z = 62x − y + z = 3x + 2y − z = 4​

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
ମଇ 2025 ରେ କେନ୍ଦ୍ର କ୍ୟାବି ନେଟ (ITI) ଗୁ ଡ଼ି କର ଉନ୍ନୟନ ଏବଂ ପାଞ୍ଚଟି  ଉତ୍କର୍ଷ  କେନ୍ଦ୍ର
ପ୍ର ତି ଷ୍ଠା ପାଇଁ  ଉଦ୍ଦି ଷ୍ଟ ଜାତୀୟ ଯୋଜନା ନି ମନ୍ତେ କେତେ ପରି ମାଣର ଟଙ୍କା ମଞ୍ଜୁ ର
କରି ଥି ଲେ?

A.  ₹30,000 କୋଟି

B.  ₹45,000 କୋଟି

C.  ₹60,000 କୋଟି

D.  ₹75,000 କୋଟି

✓

Q22 GA
ନି ମ୍ନ ଲି ଖି ତ ବ୍ୟକ୍ତି ମାନଙ୍କ ମଧ୍ୟରୁ  କି ଏ ଏପ୍ରି  ଲ 2025 ରେ ଭାରତର 23 ତମ ଆଇନ
ଆୟୋଗର ଅଧ୍ୟକ୍ଷ ଭାବରେ ନି ଯୁ କ୍ତ ହୋଇଛନ୍ତି ?

A.  ଦି ନେଶ ମାହେଶ୍ୱରୀ

B.  ବଲବୀର ସିଂ ହ ଚୌହାନ

C.  ହି ତେଶ ଜୈ ନ 

D.  D.P. ବର୍ମା

✓

Q23 GA
ଗୌରୀଶଙ୍କର ରାୟଙ୍କ ଦ୍ୱାରା 1866 ମସି ହାରେ ପ୍ର ଥମେ ପ୍ର କାଶି ତ କେଉଁ  ସମ୍ବାଦପତ୍ର
ଓଡ଼ି ଶାରେ ସାମାଜି କ ସଂସ୍କାରର ଏକ ମାଧ୍ୟମ ପାଲଟି ଥି ଲା?

A.  ଉତ୍କଳ ଦୀପି କା 

B.  ସମାଜ

C.  ପ୍ର ଜାମଣ୍ଡଳ ପତ୍ରି  କା

D.  ସମ୍ବଲପୁ ର ହି ତୈ ଷି ଣୀ

✓

Q24 GA
ଲରେଅସ ୱାର୍ଲ୍ଡ  ସ୍ପୋର୍ଟ ସ ଆୱାର୍ଡ ସ (Laureus World Sports Awards) 2025 ରେ
କି ଏ ବର୍ଷ ର ଶ୍ରେ ଷ୍ଠ ମହି ଳା କ୍ରୀ ଡ଼ାବି ତ ପୁ ରସ୍କାର ଜି ତି ଥି ଲେ?

A.  ଆରି ନା ସାବାଲେଙ୍କା (Aryna Sabalenka)

B.  ଫେଥ କି ପି ଗନ (Faith Kipyegon)

C.  ଆଇଟାନା ବୋନମାଟି  (Aitana Bonmati)

D.  ସି ମୋନ ବାଇଲ୍ସ  (Simone Biles)

✓

Q25 GA
71 ତମ ଜାତୀୟ ଚଳଚ୍ଚି ତ୍ର  ପୁ ରସ୍କାର 2025 ରେ ଶ୍ରେ ଷ୍ଠ ଓଡ଼ି ଆ ଚଳଚ୍ଚି ତ୍ର  ଭାବେ ପୁ ରସ୍କୃତ
'ପୁ ଷ୍କରା' ଚଳଚ୍ଚି ତ୍ର ର ନି ର୍ଦ୍ଦେ ଶନା କି ଏ ଦେଇଥି ଲେ?

A.  ସବ୍ୟସାଚୀ ମହାପାତ୍ର

B.  ଶୁ ଭ୍ରାଂ ସୁ  ଦାସ 

C.  ପ୍ର ଶାନ୍ତ ନନ୍ଦ

D.  ସୁ ଶାନ୍ତ ମି ଶ୍ର  

✓

Q26 GA
1857 ବି ଦ୍ରୋ ହର ତତ୍କାଳୀନ କାରଣ ଥି ଲା ଏକ ନୂ ତନ ରାଇଫଲ କାର୍ଟ୍ରିଜର ପ୍ର ଚଳନ,
ଯାହା ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ପଶୁ ର ଚର୍ବିରେ ଗ୍ରୀ ସ ହେଉଥି ଲା?

A.  ଘୁ ଷୁ ରୀ ଓ ଛେଳି

B.  ଗାଈ ଓ ଘୁ ଷୁ ରୀ

C.  ମଇଁ ଷି  ଓ ଛେଳି

D.  ଗାଈ ଓ ମେଣ୍ଢା

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q27 GA
କୋଷର ଚୟାପଚୟ ପ୍ର କ୍ରି  ୟାରେ କୋଷଜୀବକ (cytoplasm) ର ଭୂ ମି କାକୁ  କେଉଁ  ବି ବୃ ତ୍ତି
ସର୍ବୋ ତ୍ତମ ଭାବେ ବର୍ଣ୍ଣ ନା କରେ?

A.  ଏହା DNA ଷ୍ଟୋରେଜ ପାଇଁ  ଏକ ସ୍ଥାନ ଅଟେ

B.  ଏହା କୋଷି କାକୁ  ଫାଟି ଯି ବାରୁ  ରକ୍ଷା କରି ଥାଏ

C.  ଏଥି ରେ ଅଙ୍ଗି କାଗୁ ଡି ଏ ଥାଏ

D.  ଏହା ଏକ ଦୃ ଢ଼ ଆଭ୍ୟନ୍ତରୀଣ କଙ୍କାଳ ଭାବରେ କାର୍ଯ୍ୟ  କରେ

✓

Q28 GA
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ବେଗରେ ବୃ ତ୍ତାକାର ପଥରେ ଗତି  କରୁ ଥି ବା ଏକ ବସ୍ତୁ ତ୍ୱରାନ୍ୱି  ତ ହୋଇଥାଏ,
କାରଣ __________।

A.  ଏହାର ବସ୍ତୁତ୍ୱ ନି ରନ୍ତର ପରି ବର୍ତ୍ତ ନ ହେଉଛି

B.  ଏହାର ପରି ବେଗର ଦି ଗ ନି ରନ୍ତର ପରି ବର୍ତ୍ତ ନ ହେଉଛି  

C.  ଏହାର ବ୍ୟାସାର୍ଦ୍ଧ  ନି ରନ୍ତର ପରି ବର୍ତ୍ତ ନ ହେଉଛି

D.  ଏହାର ଶକ୍ତି  ହ୍ରା ସ ପାଉଛି

✓

Q29 GA
ଓଡ଼ି ଶାର ଜଳବାୟୁ  ପରି ସ୍ଥି ତି କୁ  କେଉଁ  ପଦ ସର୍ବୋ ତ୍ତମ ଭାବରେ ବର୍ଣ୍ଣ ନା କରି ଥାଏ?

A.  ତୁ ନ୍ଦ୍ରା

B.  କ୍ରା ନ୍ତୀୟ ମୌସୁ ମୀ

C.  ଭୂ ମଧ୍ୟସାଗରୀୟ

D.  ମହାଦେଶୀୟ

✓

Q30 GA
କେଉଁ  ଉପନ୍ୟାସ ନଭେମ୍ବର ମାସରେ ପ୍ର ତି ଷ୍ଠି ତ ବୁ କର ପୁ ରସ୍କାର 2025 ଜି ତି ଥି ଲା?

A.  ଫ୍ଲେ ଶ ବାଇ ଡେଭି ଡ ସାଲେ (Flesh by David Szalay)

B.  ଜେମ୍ସ  ବାଇ ପର୍ସିଭାଲ ଏଭରେଟ (James by Percival Everett)

C.  ଅଡି ସନ ବାୟ - କେଟି  କି ଟାମୁ ରା (Audition by Katie Kitamura)

D.  ଦି  ଲ୍ୟାଣ୍ଡ ଇନ ୱି ଣ୍ଟର ବାୟ ଆଣ୍ଡ୍ର୍ୟୁ ମି ଲର (The Land in Winter by
Andrew Miller)

✓

Q31 GA
ଉପଦ୍ୱୀପ ମାଳଭୂ ମି ର ଅଧି କାଂଶ ନଦୀ କାହିଁକି  ବଙ୍ଗୋପସାଗର ଆଡକୁ  ପ୍ର ବାହି ତ ହୁ ଏ
ତାହା ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସବୁ ଠାରୁ  ଭଲ ଭାବରେ ବ୍ୟାଖ୍ୟା କରେ?

A.  ପଶ୍ଚି ମ ଘାଟ ଅଧି କାଂଶ ନଦୀର ପଶ୍ଚି ମମୁ ଖୀ ପ୍ର ବାହକୁ  ପ୍ର ତି ବନ୍ଧକ କରେ

B.  ଏହି  ମାଳଭୂ ମି  ସାମାନ୍ୟ ଭାବେ ପୂ ର୍ବ  ଦି ଗକୁ  ଢାଳୁ ଆ ହୋଇ ରହି ଛି

C.  ବୃ ଷ୍ଟି ପାତର ଢାଞ୍ଚାରେ ପରି ବର୍ତ୍ତ ନ ନଦୀର ପ୍ର ବାହ ଦି ଗକୁ  ନି ର୍ଦ୍ଧା ରଣ କରି ଥାଏ

D.  ମୃ ତ୍ତି କା ପ୍ର କାରର ପରି ବର୍ତ୍ତ ନ ସି ଧାସଳଖ ନଦୀ ପ୍ର ବାହର ଗତି ପଥକୁ  ପ୍ର ଭାବି ତ
କରି ଥାଏ

✓

Q32 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ସହରକୁ  ଓଡ଼ି ଶାର ନୂ ତନ ପୋଲି ସ ଜି ଲ୍ଲା ଭାବରେ ସୂ ଚି ତ
କରାଯାଇଥି ଲା, ଯାହା ମୟୂ ରଭଞ୍ଜ ଜି ଲ୍ଲାରୁ  ଅଲଗା ହେବା ପରେ ଜାନୁ ଆରୀ 2026 ରେ
ସରକାରୀ ଭାବେ କାର୍ଯ୍ୟ କ୍ଷମ ହୋଇଥି ଲା?

A.  ବାରି ପଦା

B.  ରାଇରଙ୍ଗପୁ ର

C.  କରଞ୍ଜି ଆ

D.  ଉଦଳା

✓

Q33 GA
ଉତ୍ତର ଗୋଲାର୍ଦ୍ଧ  (Northern Hemisphere) ସୂ ର୍ଯ୍ୟ ଙ୍କ ଆଡ଼କୁ  ଢଳି  ରହି ଲେ, ସେଠାରେ
କେଉଁ  ଋତୁ  ଅନୁ ଭୂ ତ ହୁ ଏ?

A.  ଶୀତ

B.  ଗ୍ରୀ ଷ୍ମ

C.  ଶରତ

D.  ବସନ୍ତ 

✓

Q34 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଭାରତରେ ଜନଗଣନାକୁ  ସର୍ବୋ ତ୍ତମ ଭାବରେ ବ୍ୟାଖ୍ୟା କରେ?

A.  କେବଳ ସହରାଞ୍ଚଳରେ କରାଯାଇଥି ବା ଏକ ସର୍ବେ କ୍ଷଣ

B.  ନି ୟମି ତ ବ୍ୟବଧାନରେ କରାଯାଉଥି ବା ଜନସଂଖ୍ୟାର ଏକ ସରକାରୀ ଗଣନା

C.  ସମୟାନୁ କ୍ର ମେ ଜଳବାୟୁ  ଢାଞ୍ଚାର ଏକ ଅଧ୍ୟୟନ 

D.  କେବଳ ଅର୍ଥ ନୈ ତି କ କାର୍ଯ୍ୟ କଳାପର ଏକ ରେକର୍ଡ  

✓

Q35 GA
ବୁ ଦ୍ଧଙ୍କ ପୂ ର୍ବ  ଜନ୍ମ  ସମ୍ପର୍କିତ କାହାଣୀ ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଗ୍ର ନ୍ଥମାନଙ୍କରେ ଦେଖି ବାକୁ  ମି ଳେ?

A.  ବି ନୟ ପି ଟକ

B.  ଅଭି ଧମ୍ମ ପି ଟକ

C.  ଜାତକ କାହାଣୀ

D.  ଉପନି ଷଦ

✓

Q36 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ନୀତି ଗତ ପଦକ୍ଷେପ ସମ୍ବଳର ଧାରଣୀୟ ବ୍ୟବହାର ନୀତି  (principle of
sustainable resource use) କୁ  ପ୍ର ତି ଫଳି ତ କରେ?

A.  କୃ ଷି  ଉତ୍ପାଦନ ବୃ ଦ୍ଧି  ନି ମନ୍ତେ ଭୂ ତଳ ଜଳର ପୁ ନର୍ଭ ରଣ କ୍ଷମତାଠାରୁ  ଅଧି କ ଜଳ
ବ୍ୟବହାର କରି ବା

B.  ସ୍ଥାୟୀ ଆର୍ଥିକ ଅଭି ବୃ ଦ୍ଧି  ସୁ ନି ଶ୍ଚି ତ କରି ବା ସହ ପାରି ପାର୍ଶ୍ୱିକ ସୀମା ମଧ୍ୟରେ
ସମ୍ବଳ ନି ଷ୍କାସନକୁ  ନି ୟନ୍ତ୍ରି ତ କରି ବା

C.  ଉତ୍ପାଦନ ବୃ ଦ୍ଧି  ପାଇଁ  ପାରମ୍ପରି କ ଜୀବି କା ବଦଳରେ ଶି ଳ୍ପଭି ତ୍ତି କ ନି ଯୁ କ୍ତି କୁ  ପ୍ରା ଧାନ୍ୟ
ଦେବା

D.  ଦୀର୍ଘ କାଳୀନ ପାରି ପାର୍ଶ୍ୱିକ ସ୍ଥି ରତା ଅପେକ୍ଷା ସ୍ୱଳ୍ପକାଳୀନ ଆର୍ଥିକ ଲାଭକୁ
ଅଗ୍ରା ଧି କାର ଦେବା
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✓

Q37 GA
ଭାରତୀୟ ଲୋକ କଳାକାର ତୀଜନ ବାଇ ମହାଭାରତର ଚରି ତ୍ର ମାନଙ୍କୁ  ନେଇ ଅଭି ନୟ
କରୁ ଥି ବା କେଉଁ  ଲୋକପରମ୍ପରା ସହି ତ ବି ଶେଷ ଭାବେ ଜଡ଼ି ତ?

A.  ବାଉଲ

B.  ପାଣ୍ଡବାନୀ

C.  ଭାୱାଇୟା

D.  ଭଟି ଆଲି

✓

Q38 GA
ଭାରତୀୟ ସମ୍ବି ଧାନର ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦଗୁ ଡି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସାମ୍ବି ଧାନି କ ପ୍ର ତି କାର
ଅଧି କାର ସହ ସଂପୃ କ୍ତ ଅଟେ?

A.  ଅନୁ ଚ୍ଛେଦ 14 

B.  ଅନୁ ଚ୍ଛେଦ 19

C.  ଅନୁ ଚ୍ଛେଦ 32

D.  ଅନୁ ଚ୍ଛେଦ 21

✓

Q39 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ପ୍ର ଧାନମନ୍ତ୍ରୀ ଗ୍ରା ମ ସଡ଼କ ଯୋଜନା (PMGSY) ର ମୁ ଖ୍ୟ
ଉଦ୍ଦେଶ୍ୟକୁ  ସର୍ବୋ ତ୍ତମ ଭାବରେ ବର୍ଣ୍ଣ ନା କରେ?

A.  କୃ ଷକମାନଙ୍କୁ  ଜଳସେଚନ ସୁ ବି ଧା ପ୍ର ଦାନ କରି ବା

B.  ଗ୍ରା ମାଞ୍ଚଳର ଜନବସତି ଗୁ ଡ଼ି କୁ  ପକ୍କା ରାସ୍ତା ଦ୍ୱାରା ସଂଯୋଗ କରି ବା

C.  ଗ୍ରା ମାଞ୍ଚଳ ପରି ବାରଗୁ ଡ଼ି କୁ  ମାଗଣା ବି ଦ୍ୟୁ ତ୍  ଶକ୍ତି  ପ୍ର ଦାନ କରି ବା

D.  ଗ୍ରା ମୀଣ ବ୍ୟାଙ୍କି ଙ୍ଗ୍  ସେବାର ପ୍ର ଚାର ଓ ପ୍ର ସାର 

✓

Q40 GA
ହାଇଡ୍ରୋ କ୍ଲୋ ରି କ ଏସି ଡ (HCL) ସୋଡି ୟମ ହାଇଡ୍ରୋ କ୍ସାଇଡ (NaOH) ସହ ପ୍ର ତି କ୍ରି  ୟା
କଲେ କ'ଣ ଘଟି ଥାଏ?

A.  ଏକ ଗ୍ୟାସ ନି ର୍ଗ ତ ହୁ ଏ ।

B.  ଏକ ନି ଷ୍କ୍ରି ୟ ଲବଣ (neutral salt) ଓ ଜଳ ସୃ ଷ୍ଟି  ହୁ ଏ ।

C.  ଏହାର ଦ୍ର ବଣ ଅମ୍ଳୀ ୟ ହୋଇଯାଏ ।

D.  ପ୍ର ତି କ୍ରି  ୟା ହୁ ଏ ନାହିଁ ।

English

✓

Q41 English
Select the option that can be used as a one-word substitute for the given group of words.

A remedy for all diseases

A.  Placebo

B.  Elixir

C.  Panacea

D.  Anodyne

✓

Q42 English
Rearrange the following parts of a sentences to create a meaningful sentence:

P: many of whom had initially dismissed the idea as unrealistic,

Q: the proposal eventually gained the support of senior stakeholders,

R: after the revised strategy was presented with clear data and projections,

S: convincing them of its long-term viability

A.  R Q P S

B.  S Q P R

C.  Q P S R

D.  P S Q R
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✓

Q43 English
Read the sentence carefully and choose the word that is opposite in meaning to the word in bold.
The racer was vigilant throughout the night before the big race.

A.  Observant

B.  Apparent

C.  Negligent

D.  Heedful

✓

Q44 English
Which of the following sentences is/are in direct speech?
A. They said, "How amazing the view from here is!"
B. They said to me, "She baked the biscuits."
C. They asked why they were late?
D. Babu said that he was happy.

A.  Both A and B

B.  Both B and C

C.  Only C

D.  Both D and C

✓

Q45 English
Choose the sentence that is correctly written in the Future tense.

A.  They will hiking all day tomorrow.

B.  They will have hiking all day tomorrow.

C.  They will be hiking all day tomorrow.

D.  They are hike all day tomorrow.

✓

Q46 English
Rectify the following sentence by choosing the option that has the correct spelling of the incorrectly spelled word.

His ephemeral success in the competition only added to the ambiguity of his future career, leaving many wondering about his fortuitious rise to
fame.

A.  ephemiral

B.  compitition

C.  ambiguty

D.  fortuitous
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✓

Q47 English
Which of the following sentences is/are in passive voice?
A. We do not know him.
B. The room was filled with smoke.
C. Alas! we shall hear his voice no more.
D. You are being watched carefully.

A.  Both A and C

B.  Only A

C.  Only B

D.  Both B and D

✓

Q48 English
Identify the antonym of the word (fragile) in the following passage from the given options.
The vase was fragile and delicate, likely to break easily. In contrast, the metal sculpture was sturdy, strong, and solid, able to withstand
pressure. The artist also displayed a pliant structure that could bend without breaking.

A.  Sturdy

B.  Solid

C.  Delicate

D.  Pliant

✓

Q49 English

Read the passage carefully and answer the questions that follow.

In the dense forests of Western Ghats, the Malabar hornbill is a symbol of resilience and ecological balance. This large bird, with its striking
yellow beak and black plumage, plays a vital role in seed dispersal, helping maintain the forest’s biodiversity. Local communities regard it with
reverence, associating its presence with the health of the forest. Despite its importance, the hornbill faces threats from deforestation and habitat
fragmentation. Conservationists have initiated awareness programs, teaching villagers the significance of protecting these birds and their
habitats. Efforts include establishing nesting boxes, prohibiting hunting, and restoring native trees. These combined actions aim to ensure that
future generations witness the hornbill soaring through the forests, a living reminder of nature’s delicate balance. The survival of this species is
intertwined with human responsibility, illustrating that coexistence and environmental stewardship are essential for sustaining life.

What role does the Malabar hornbill play in the forest?

A.  Predator of insects

B.  Seed disperser

C.  Forest guard

D.  Soil enhancer

✓

Q50 English
What is the central theme of the passage?

A.  Importance of wildlife conservation

B.  Hunting practices in forests

C.  Economic value of forests

D.  Climate change impact
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✓

Q51 English
What can be inferred about local communities?

A.  They are unaware of environmental issues.

B.  They revere and protect forest species.

C.  They hunt hornbills for food.

D.  They avoid the forests completely.

✓

Q52 English
What is the tone of the passage?

A.  Concerned and informative

B.  Humorous

C.  Critical

D.  Nostalgic

✓

Q53 English
Which title best suits the passage?

A.  The Malabar Hornbill and Forest Conservation

B.  Hunting in the Western Ghats

C.  Birds of Prey

D.  Economic Importance of Forests

✓

Q54 English
Select the most appropriate one-word substitute for the underlined group of words in the given sentence.

The villagers finally revolted against the king's rule, calling for a leader who would rule with complete power and absolute authority.

A.  Philosopher

B.  Democrat

C.  Reformer

D.  Autocrat

✓

Q55 English
Replace the given word segment with the correct proverb.

A person who keeps changing places or jobs gains no stability.

A.  A stitch in time saves nine.

B.  A rolling stone gathers no moss.

C.  Where there’s a will, there’s a way.

D.  Don’t count your chickens before they hatch.
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✓

Q56 English
Select the correct meaning of the idiom that can replace the underlined words.

The researcher refused to cut corners while conducting the clinical trials.

A.  reduce costs legally

B.  follow outdated procedures

C.  skip essential steps

D.  complete the task early

✓

Q57 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

In classical music, Beethoven’s Symphony No. 9 is commonly referred to as one of _____ most profound compositions in history.

A.  a

B.  an

C.  the

D.  No article required

✓

Q58 English
Choose the word that best completes the sentence.
We have a __________ vacation next month.3721

A.  longer

B.  longest

C.  long

D.  longing
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✓

Q59 English
Select the most appropriate option to fill in the blank.

The rider lost control and fell _____ the bike.

A.  from

B.  on

C.  with

D.  off

✓

Q60 English
The question below consists of a set of labeled phrases. Out of the four options given, select the most logical order to form a coherent
sentence.

P: that served as a safe haven
Q: during the thunderstorm
R: we found a small cave
S: near the rocky edge of the hill

A.  RSPQ

B.  QSRP

C.  SRQP

D.  PSQR

Odia

✓

Q61 Odia
ଅବ୍ୟୟ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

ଗାଡ଼ି ଟା ____ ଶବ୍ଦ କରି  ଚାଲି ଗଲା ।

A.  ହେସ ହେସ

B.  ମଡ଼ ମଡ଼

C.  ଫଟ ଫଟ

D.  ଗୁ ଣୁ  ଗୁ ଣୁ

✓

Q62 Odia
ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

'' ପୂ ର୍ଣ ମୀ ରାତି ରେ ଚନ୍ଦ୍ର ____ ଉଜ୍ଜ୍ୱଳ ଦି ଶେ ।''

A.  କମ

B.  କ୍ଷୀଣ

C.  ଭାରି

D.  ଖୁ ବ
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✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ସମାନାର୍ଥ ବୋଧକ ଶବ୍ଦ ଲେଖ।
ପାଣି  ହେଉଛି  ଜୀବନ, ଆମେ "ଜଳ" ବି ନା ବଞ୍ଚି  ପାରି ବୁ ନି ।

A.  ଅଗ୍ନି

B.  ପାଣି

C.  ପବନ

D.  ଧୁ ଳି

✓

Q64 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
କୃ ତ୍ରି  ମ ବୁ ଦ୍ଧି ମତା ପ୍ର ତି ମାନ ପ୍ର ଦତ୍ତ ତଥ୍ୟ ଠି କରେ ବ୍ୟବହାର କରି  ଶି ଖି  ପାରି ବ ।

A.  This AI model can learn by itself using the given data correctly.

B.  This AI model can learns by itself using given data correct.

C.  This AI model can learning by itself with the data correctly.

D.  This AI model can learnt by itself using the data correct.

✓

Q65 Odia
ସଠି କ ତଦ୍ଭବ ଶବ୍ଦ ବାଛନ୍ତୁ: “ଜଳ” ର ତଦ୍ଭବ କଣ?

A.  ପାଣି

B.  ପାଣୀ

C.  ପାଣିଁ

D.  ପାଣର

✓

Q66 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ନି ରଧର

A.  ପାଣି

B.  ବର୍ଷା

C.  ମେଘ

D.  ପାଗ

✓

Q67 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

କାଲି  ଅଫି ସ ରୁ  ଫେରି ଲା ପରେ ତୁ ମ ଘରକୁ  ଯି ବି  ।

A.  I will go to your house tomorrow after office.

B.  I was going to your house after returning from office.

C.  I will go tomorrow after returning from office.

D.  I will go to your house tomorrow after returning from office.
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✓

Q68 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

ପ୍ରା ଚୀନ ଓଡ଼ି ଶାର ଇତି ହାସ, ଯାହାକି  କଳି ଙ୍ଗ ନାମରେ ପରି ଚି ତ ସାଂସ୍କୃତି କ ସମୃ ଦ୍ଧି , ସାମୁ ଦ୍ରି  କ ଗୌରବ ଏବଂ ରାଜନୈ ତି କ ବି ବର୍ତ୍ତ ନର ଏକ ଅଂଶ । ମହାଭାରତ ଏବଂ ପୁ ରାଣ ଭଳି  ପ୍ରା ଚୀନ ଭାରତୀୟ
ଗ୍ର ନ୍ଥରେ କଳି ଙ୍ଗର ପ୍ରା ରମ୍ଭି କ ଉଲ୍ଲେଖର ଦୃ ଶ୍ୟମାନ ହୋଇଥାଏ , ଏହାକୁ  ଭାରତର ପୂ ର୍ବ  ଉପକୂ ଳରେ ଅବସ୍ଥି ତ ଏକ ଶକ୍ତି ଶାଳୀ ଏବଂ ସମୃ ଦ୍ଧ ରାଜ୍ୟ ଭାବରେ ବର୍ଣ୍ଣ ନା କରାଯାଏ । ପ୍ର ତ୍ନତାତ୍ତ୍ୱି କ ପ୍ର ମାଣରୁ
ଜଣାପଡ଼େ ଯେ ଓଡ଼ି ଶାରେ ସଭ୍ୟତା ପ୍ରା ଗୈ ତି ହାସି କ ଯୁ ଗରୁ  ଆରମ୍ଭ ହୋଇଥି ଲା, ମୟୂ ରଭଞ୍ଜ ଏବଂ ସୁ ନ୍ଦରଗଡ଼ ଭଳି  ଅଞ୍ଚଳରେ ପଥର ଉପକରଣ ଏବଂ ନବପ୍ରା ଥମି କ ବସତି  ଆବି ଷ୍କାର ହୋଇଥି ଲା।
ମୌର୍ଯ୍ୟ  ସାମ୍ରା ଜ୍ୟର ସମ୍ରା ଟ ଅଶୋକଙ୍କ ରାଜତ୍ୱ ସମୟରେ କଳି ଙ୍ଗର ପ୍ରା ଚୀନତା ଉଲ୍ଲେଖନୀୟ ଭାବରେ ବୃ ଦ୍ଧି  ପାଇଥି ଲା। 261 ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ ରେ ଲଢ଼ି ଥି ବା ପ୍ର ସି ଦ୍ଧ କଳି ଙ୍ଗ ଯୁ ଦ୍ଧ ଭାରତୀୟ ଇତି ହାସରେ
ଏକ ନୂ ତନ ମୋଡ଼ରେ ପହଞ୍ଚାଇଥି ଲା। ଯୁ ଦ୍ଧ ସମୟର ପ୍ର ଚଣ୍ଡ ରକ୍ତପାତ ଅଶୋକଙ୍କୁ  ଗଭୀର ଭାବରେ ପ୍ର ଭାବି ତ କରି ଥି ଲା |ଏହି  ଘଟଣା ତାଙ୍କୁ  ବୌଦ୍ଧ ଧର୍ମ  ଗ୍ର ହଣ କରି ବାକୁ  ଏବଂ ସମଗ୍ର  ଏସି ଆରେ
ବୌଦ୍ଧ ଶି କ୍ଷାର ପ୍ର ସାରକୁ  ପ୍ର ବର୍ତ୍ତା ଇଥି ଲା । ମୌର୍ଯ୍ୟ  ପତନ ପରେ, କଳି ଙ୍ଗ ପୁ ଣି  ଥରେ ସ୍ୱାଧୀନତା ପାଇଲା ଏବଂ ବାଣି ଜ୍ୟ ଏବଂ ସଂସ୍କୃତି ର ଏକ ପ୍ର ମୁ ଖ କେନ୍ଦ୍ର ପାଲଟି ଯାଇଥି ଲା ।

ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ  ତୃ ତୀୟ ଶତାବ୍ଦୀରୁ  ଦଶମ ଶତାବ୍ଦୀ ମଧ୍ୟରେ, ଓଡ଼ି ଶାରେ ମହାମେଘବାହନ, ସାତବାହନ ଏବଂ ଭୌମ-କାର ସମେତ ଅନେକ ଶକ୍ତି ଶାଳୀ ରାଜବଂଶର ଉତ୍ଥାନ ହୋଇଥି ଲା। ସେମାନଙ୍କ
ମଧ୍ୟରୁ  ସବୁ ଠାରୁ  ଉଲ୍ଲେଖନୀୟ ଥି ଲେ ମହାମେଘବାହନ ରାଜବଂଶର ରାଜା ଖାରବେଳ , ଯି ଏ ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ  ପ୍ର ଥମ ଶତାବ୍ଦୀରେ ଶାସନ କରି ଥି ଲେ। ତାଙ୍କ ଶାସନ କାଳ ଉଦୟଗି ରି  ଗୁ ମ୍ଫା ନି କଟରେ ଥି ବା
ପ୍ର ସି ଦ୍ଧ ହାତି ଗୁ ମ୍ଫା ଶି ଳାଲେଖରେ ବର୍ଣ୍ଣ ନା କରାଯାଇଛି , ଯାହା ତାଙ୍କର ସାମରି କ ବି ଜୟ ଏବଂ କଳା ଏବଂ ଧର୍ମ ର ପୃ ଷ୍ଠପୋଷକତା ବର୍ଣ୍ଣ ନା କରେ। ପରେ, ସୋମବଂଶୀ ଏବଂ ଗଙ୍ଗ ରାଜବଂଶ ଓଡ଼ି ଶାର
ରାଜନୈ ତି କ ଏବଂ ସାଂସ୍କୃତି କ ପରି ଚୟକୁ  ଆହୁ ରି  ସୁ ଦୃ ଢ଼ ​​କରି ଥି ଲା। ପ୍ରା ଚୀନ ଓଡ଼ି ଶା ଏହାର ନୌବାଣି ଜ୍ୟ କାର୍ଯ୍ୟ କଳାପ ପାଇଁ  ମଧ୍ୟ ପ୍ର ସି ଦ୍ଧ ଥି ଲା, ବ୍ୟବସାୟୀମାନେ ଜାଭା, ବାଲି  ଏବଂ ସୁ ମାତ୍ରା  ଭଳି
ଦକ୍ଷି ଣ-ପୂ ର୍ବ  ଏସୀୟ ଅଞ୍ଚଳକୁ  ଯାତ୍ରା  କରୁ ଥି ଲେ ଓ ସାଂସ୍କୃତି କ ଏବଂ ବାଣି ଜ୍ୟି କ ସମ୍ପର୍କ  ସ୍ଥାପନ କରୁ ଥି ଲେ।

ପ୍ରା ଚୀନ କାଳରେ, ଓଡ଼ି ଶା କଳା, ସ୍ଥାପତ୍ୟ ଏବଂ ଆଧ୍ୟାତ୍ମି କତାର ଏକ ଅନନ୍ୟ ମି ଶ୍ର ଣ ବି କଶି ତ କରି ଥି ଲା, ଯାହା ଏହାର ପଥର-ଖୋଦା ଗୁ ମ୍ଫା, ମନ୍ଦି ର ସ୍ଥାପତ୍ୟ ଏବଂ ଭାସ୍କର୍ଯ୍ୟ ରେ ସ୍ପଷ୍ଟ। ପ୍ରା ଚୀନ କାଳର
ଶେଷ ସୁ ଦ୍ଧା, ଓଡ଼ି ଶା ପୂ ର୍ବ  ଭାରତରେ ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଅଞ୍ଚଳ ଭାବରେ ଉଭା ହୋଇଥି ଲା, ଯାହା ଉପମହାଦେଶର ଧାର୍ମିକ, ସାଂସ୍କୃତି କ ଏବଂ କଳାତ୍ମକ ଐତି ହ୍ୟକୁ  ଅବଦାନ ଦେଇଥି ଲା।

ଓଡ଼ି ଶାର ପ୍ରା ଚୀନ ନାମ କ'ଣ ଥି ଲା?

A.  ଅଙ୍ଗ

B.  କଳି ଙ୍ଗ

C.  କୋଶଳ

D.  ମଗଧ

✓

Q69 Odia
କଳି ଙ୍ଗ ଯୁ ଦ୍ଧରେ ଲଢ଼ି ଥି ବା ମୌର୍ଯ୍ୟ  ସମ୍ରା ଟ କି ଏ ଥି ଲେ?

A.  ଚନ୍ଦ୍ରଗୁ ପ୍ତ ମୌର୍ଯ୍ୟ

B.  ବି ନ୍ଦୁ ସାର

C.  ଅଶୋକ

D.  ହର୍ଷ

✓

Q70 Odia
କେଉଁ  ଶି ଳାଲେଖରେ ରାଜା ଖାରବେଳ ଙ୍କ ସଫଳତା ଲି ପି ବଦ୍ଧ ଅଛି ?

A.  ହାତୀଗୁ ମ୍ଫା ଶି ଳାଲେଖ

B.  ଜୁ ନାଗଡ଼ ଶି ଳାଲେଖ

C.  ଆଲ୍ଲାହାବାଦ ସ୍ତମ୍ଭ ଶି ଳାଲେଖ

D.  ମେହରୌଲି  ଶି ଳାଲେଖ

✓

Q71 Odia
କଳି ଙ୍ଗ ଯୁ ଦ୍ଧ କେବେ ହୋଇଥି ଲା?

A.  261 ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ

B.  271 ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ

C.  291 ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ

D.  285 ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ
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✓

Q72 Odia
ପ୍ରା ଚୀନ ଓଡ଼ି ଆ ବ୍ୟବସାୟୀମାନେ କେଉଁ  ଅଞ୍ଚଳକୁ  ପ୍ରା ୟତଃ ଆସୁ ଥି ଲେ?

A.  ୟୁ ରୋପ

B.  ଦକ୍ଷି ଣ ପୂ ର୍ବ  ଏସି ଆ

C.  ଆଫ୍ରି  କା

D.  ମଧ୍ୟ ଏସି ଆ

✓

Q73 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ତୁ ମ ସାଙ୍ଗରେ ଖେଳି ବାକୁ  ମୋ ପାଖରେ ସମୟ ନାହିଁ |

A.  I will not play with you at all.

B.  I was not playing with you at all.

C.  I don't have time to play with you.

D.  I don't has time to play with you.

✓

Q74 Odia
ଯେଉଁ  ପଦ ଅନ୍ୟ ପଦର ଗୁ ଣ, ଅବସ୍ଥା, ସଂଖ୍ୟା, ପରି ମାଣ ବା ନି ର୍ଦ୍ଦିଷ୍ଟତା ପ୍ର କାଶ କରେ,ତାକୁ  କ'ଣ କୁ ହାଯାଏ ।

A.  ବି ଶେଷ୍ୟ

B.  କ୍ରି  ୟା

C.  ସର୍ବ ନାମ

D.  ବି ଶେଷଣ

✓

Q75 Odia
"ଅନ୍ଧ ଦେଶକୁ  ଗଲି  ଦର୍ପ ଣ ବି କି " ଏହି  ଲୋକୋକ୍ତି ର ଅର୍ଥ  କଣ?

A.  ଦର୍ପ ଣ ବ୍ୟବସାୟ କରି ବା

B.  ଅନ୍ଧ ହେବା

C.  ଦେଶ ଭ୍ର ମଣ କରି ବା

D.  ନି ର୍ବୋ ଧମାନଙ୍କ ପାଖରେ ଜ୍ଞାନ ବଖାଣି ବା ବା ଅଯୋଗ୍ୟ ସ୍ଥାନରେ ଗୁ ଣ ଆଦର ଖୋଜି ବା
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Computer

✓

Q76 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ପଦ୍ଧତି  MS ଏକ୍ସେଲରେ ଧାଡ଼ି  ଉଚ୍ଚତା (row height) ଏବଂ ସ୍ତମ୍ଭ
ପ୍ର ସ୍ଥ (column width) କୁ  ସଠି କ୍  ଭାବରେ ଆଡଜଷ୍ଟ କରି ବା ପାଇଁ  ଅନୁ ମତି  ଦେଇଥାଏ?

A.  Home ଟ୍ୟାବରେ ଫର୍ମା ଟ ଅପସନ ବ୍ୟବହାର କରି ବା

B.  File ଟ୍ୟାବ ଉପରେ କ୍ଲି  କ କରି ବା

C.  Insert ଟ୍ୟାବ ବ୍ୟବହାର କରି ବା

D.  Formula Bar ଭି ତରେ ଡ୍ରା ଗ କରି ବା

✓

Q77 Computer
ମାଇକ୍ରୋ ସଫ୍ଟ  ଅଫି ସ ଆପରେ ଏକ ଟେମ୍ପଲେଟ କ'ଣ ଅଟେ?

A.  ଫର୍ମା ଟିଂ  ବି ନା ଏକ ରାଣ୍ଡମ ଫାଇଲ

B.  ନୂ ତନ ଫାଇଲ୍  ତି ଆରି  କରି ବା ପାଇଁ  ଏକ ପୂ ର୍ବ ରୁ -ଡି ଜାଇନ ହୋଇଥି ବା ଡକ୍ୟୁ ମେଣ୍ଟ
କି ମ୍ବା ପ୍ରେ ଜେଣ୍ଟେସନ ଲେଆଉଟର ବ୍ୟବହାର

C.  କେବଳ ପ୍ରି  ଣ୍ଟି ଙ୍ଗ ପାଇଁ  ବ୍ୟବହୃ ତ ଏକ ଫାଇଲ

D.  ଏକ ପ୍ର କାର ଫଣ୍ଟ ଶୈ ଳୀ 

✓

Q78 Computer
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଡି ଭାଇସ ଉଭୟ ଇନପୁ ଟ ଏବଂ ଆଉଟପୁ ଟ ଭାବରେ କାର୍ଯ୍ୟ  କରି ପାରି ବ?

A.  ବାରକୋଡ ରି ଡର

B.  ଟଚସ୍କ୍ରି ନ

C.  ପ୍ଲ ଟର

D.  ଜୟଷ୍ଟି କ

✓

Q79 Computer
ଏକ କମ୍ପ୍ୟୁ ଟର ସି ଷ୍ଟମରେ BIOS ଫର୍ମ ୱେର ସାଧାରଣତଃ କେଉଁ  ମେମୋରୀରେ ଷ୍ଟୋର
ହୋଇଥାଏ?

A.  ରି ଡ-ଓନଲି  ମେମୋରୀ

B.  ଇନପୁ ଟ ବଫର ମେମୋରୀ

C.  ଭର୍ଚୁ ଆଲ ପେଜିଂ  ଫାଇଲ

D.  ଏକ୍ସଟର୍ନା ଲ ଫ୍ଲା ସ ମଡ୍ୟୁ ଲ

✓

Q80 Computer
କେଉଁ  ଅପରେସନ ଫାଇଲକୁ  ମୁ ଭ କରେ?

A.  କପି -ପେଷ୍ଟ

B.  କଟ-ପେଷ୍ଟ

C.  ରି ନେମ

D.  ଡି ଲି ଟ

✓

Q81 Computer
MS ଏକ୍ସେଲରେ ଏକ ଫର୍ମୁ ଲା ଲେଖି ବା ଆରମ୍ଭ କରି ବାର ସଠି କ ଉପାୟ କେଉଁ ଟି  ଅଟେ?

A.  = (ସମାନ ଚି ହ୍ନ) ରୁ  ଆରମ୍ଭ କରନ୍ତୁ 

B.  + (ପ୍ଲ ସ ପ୍ର ତୀକ) ରୁ  ଆରମ୍ଭ କରନ୍ତୁ

C.  @ ( ଆଟ ପ୍ର ତୀକ) ରୁ  ଆରମ୍ଭ କରନ୍ତୁ

D.  # (ହାଜ ପ୍ର ତୀକ) ରୁ  ଆରମ୍ଭ କରନ୍ତୁ

✓

Q82 Computer
ଆପଣଙ୍କ କମ୍ପ୍ୟୁ ଟରର କାର୍ଯ୍ୟ କାରି ତା ଉନ୍ନତ କରି ବାରେ ସି ଷ୍ଟମ ସଫ୍ଟ ୱେରର ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ
ଭୂ ମି କା କ'ଣ?

A.  ପି କଚର ଡ୍ର  କରି ବା

B.  କମ୍ପ୍ୟୁ ଟର ସହ ଇଣ୍ଟରଆକ୍ଟ କରି ବା ସମୟରେ ୟୁ ଜରଙ୍କ ମନୋରଞ୍ଜନ କରି ବା

C.  ହାର୍ଡ ୱେର ଏବଂ ଅନ୍ୟାନ୍ୟ ସଫ୍ଟ ୱେର ମ୍ୟାନେଜ କରି ବା

D.  ଡକ୍ୟୁ ମେଣ୍ଟ କ୍ରି  ଏଟ କରି ବା

✓

Q83 Computer
ଫାଇଲଗୁ ଡ଼ି କୁ  ଆଟାଚ କରି ବା ପୂ ର୍ବ ରୁ  କାହିଁକି  ଭାଇରସ ପାଇଁ  ସ୍କାନ କରାଯି ବା ଉଚି ତ?

A.  ଏହା ଅପଲୋଡ ପ୍ର କ୍ରି  ୟାକୁ  ଦ୍ରୁ ତଗାମୀ କରି ଥାଏ

B.  ଏହା ପି କ୍ସେଲ ସଂଖ୍ୟା ହ୍ରା ସ କରି ଥାଏ

C.  HTML ମେସେଜ ପାଇଁ  ଆବଶ୍ୟକ ହୋଇଥାଏ

D.  ରେସି ପାଣ୍ଟମାନଙ୍କ ନି କଟକୁ  ମାଲୱେର ବ୍ୟାପି ବାକୁ  ରୋକି ଥାଏ

✓

Q84 Computer
କେଉଁ  MS ୱାର୍ଡ  ଫି ଚର ଆପଣଙ୍କୁ  ଟେକ୍ସଟକୁ  ବୋଲ୍ଡ  କରି ବା ପାଇଁ  ଅନୁ ମତି  ଦି ଏ?

A.  ହୋମ ଟ୍ୟାବରେ ପାରାଗ୍ରା ଫ ଗୃ ପ

B.  ଇନସର୍ଟ  ଟ୍ୟାବ

C.  ଭି ୟୁ  ଟ୍ୟାବ

D.  ହୋମ ଟ୍ୟାବରେ ଫଣ୍ଟ ଗୃ ପ

✓

Q85 Computer
Print ଅପ୍ସନ ପାଇଁ  ସର୍ଟ କଟ କ'ଣ?

A.  Ctrl + O

B.  Ctrl + P

C.  Ctrl + Print

D.  Windows + P
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✓

Q86 Computer
MS ୱାର୍ଡ  2019 ରେ ଯଦି  ଏକ ଡକ୍ୟୁ ମେଣ୍ଟ Recent Documents କି ମ୍ବା Pinned Files
ଲି ଷ୍ଟରେ ଉପଲବ୍ଧ ନ ଥାଏ, ତେବେ କେଉଁ  ପଦ୍ଧତି  ୟୁ ଜରଙ୍କୁ  ୱାର୍ଡ  ଭି ତରୁ  ସି ଧାସଳଖ ଏହାକୁ
ଓପନ କରି ବା ପାଇଁ  ଅନୁ ମତି  ଦେଇଥାଏ?

A.  File > Open > Browse ବ୍ୟବହାର କରି  ଲୋକେସନକୁ  ନାଭି ଗେଟ କରି
ଫାଇଲ ସି ଲେକ୍ଟ କରି ବା

B.  File > Open > Recent କ୍ଲି  କ କରି  Recent Pane ଭି ତରେ ସର୍ଚ୍ଚ  ବାରରେ
ଫାଇଲ ନେମକୁ  ମାନୁ ଆଲି  ଟାଇପ କରି ବା

C.  File > Info > Manage Document କୁ  ଯାଇ ଅଟୋସେଭ ଲି ଷ୍ଟରୁ  ଫାଇଲକୁ
ସି ଲେକ୍ଟ କରି ବା

D.  ଡକ୍ୟୁ ମେଣ୍ଟ ଆକ୍ସେସ କରି ବା ପାଇଁ  File ରୁ  ଏକ ବ୍ଲା ଙ୍କ ଡକ୍ୟୁ ମେଣ୍ଟ ଓପେନ କରି
ପରେ Insert > Object > Text ବ୍ୟବହାର କରି ବା

✓

Q87 Computer
ପାୱାର ପଏଣ୍ଟରେ, ଆପଣ ବି କୃ ତି  (distortion) ସୃ ଷ୍ଟି  ନକରି  କି ପରି  ଇମେଜ ର ଆକାର
ପରି ବର୍ତ୍ତ ନ କରି ପାରି ବେ?

A.  କେନ୍ଦ୍ରରୁ  ଡ୍ରା ଗ କରି ବା

B.  ଜୁ ମ ବଟନ୍  ବ୍ୟବହାର କରି ବା

C.  ସାଇଡ ହ୍ୟାଣ୍ଡେଲରୁ  ଟାଣି ବା

D.  Shift କୀକୁ  ଦାବି ଧରି  କର୍ନ ର ହ୍ୟାଣ୍ଡେଲରୁ  ଡ୍ରା ଗ କରି ବା

✓

Q88 Computer
ଏକ ସି ଲେକ୍ଟଟ ହୋଇଥି ବା ଶେପ (shape) କି ମ୍ବା ଟେକ୍ସଟ ବକ୍ସ ଭି ତରେ ଟେକ୍ସଟ ଏଡ଼ି ଟି ଙ୍ଗ
ଆରମ୍ଭ କରି ବା ପାଇଁ  ପାୱାରପଏଣ୍ଟରେ କେଉଁ  କୀବୋର୍ଡ  ସର୍ଟ କଟ ବ୍ୟବହାର କରାଯାଏ?

A.  F2

B.  F5

C.  Ctrl + E

D.  Alt + Enter

✓

Q89 Computer
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ସି କ୍ୱେନ୍ସ , ଜି ମେଲ (Gmail) ବ୍ୟବହାର କରି  ଇ-ମେଲ କି ପରି  ଲେଖି ବେ ଓ
ସେଣ୍ଡ କରି ବେ ତାହା ସଠି କ ଭାବରେ ଦର୍ଶା ଉଛି ?

A.  ଲଞ୍ଚ ବ୍ରା ଉଜର → ମେସେଜ ଟାଇପ କରନ୍ତୁ → ସେଣ୍ଡ (Send) ଉପରେ କ୍ଲି  କ କରନ୍ତୁ
→ ଇମେଲ କମ୍ପୋଜ କରନ୍ତୁ → ସାଇନ ଇନ କରନ୍ତୁ

B.  ଇଣ୍ଟରନେଟ ଆକ୍ସେସ କରନ୍ତୁ → ଜି ମେଲ ଲଗ ଇନ କରନ୍ତୁ → 'କମ୍ପୋଜ
(Compose)' ସି ଲେକ୍ଟ କରନ୍ତୁ → ଡି ଟେଲ ଏଣ୍ଟର କରନ୍ତୁ → ସେଣ୍ଡ (Send) ଉପରେ
କ୍ଲି  କ କରନ୍ତୁ

C.  ଜି ମେଲ ଓପନ କରନ୍ତୁ → କମ୍ପୋଜ (Compose) ଉପରେ କ୍ଲି  କ କରନ୍ତୁ → ସାଇନ
ଇନ କରନ୍ତୁ → ମେସେଜ ଟାଇପ କରନ୍ତୁ → ସେଣ୍ଡ (Send) ଉପରେ କ୍ଲି  କ କରନ୍ତୁ

D.  ମେସେଜ ଟାଇପ କରନ୍ତୁ → ସବଜେକ୍ଟ ଲେଖନ୍ତୁ → ଜି ମେଲ କୁ  ଯାଆନ୍ତୁ →
ରି ସି ପି ଏଣ୍ଟସ (recipients) ଆଡ କରନ୍ତୁ → ସେଣ୍ଡ କରନ୍ତୁ

✓

Q90 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏକ ୱାର୍କ ବୁ କକୁ  PDF କି ମ୍ବା CSV ଭଳି  ଭି ନ୍ନ ଫର୍ମା ଟରେ ସେଭ
କରି ବାକୁ  ଅନୁ ମତି  ଦି ଏ?

A.  ସେଭ

B.  ସେଭ ଆଜ

C.  ଏକ୍ସପୋର୍ଟ

D.  ଫର୍ମା ଟ୍
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Reasoning

✓

Q91 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ ଭାଷାରେ,
‘A @ B’ ର ଅର୍ଥ  ‘A ହେଉଛି  B ର ଭାଇ’,
‘A – B’ ର ଅର୍ଥ  ‘A ହେଉଛି  B ର ସ୍ତ୍ରୀ’,
‘A x B’ ର ଅର୍ଥ  ‘A ହେଉଛି  B ର ଭଉଣୀ’ ଏବଂ
‘A # B’ ର ଅର୍ଥ  ‘A ହେଉଛି  B ର ପୁ ଅ’ ।

ଯଦି  ‘A x C # B – E @ D’ ହୁ ଏ, ତେବେ A ସମ୍ପର୍କ ରେ D ଙ୍କର କ'ଣ ହେବେ?

A.  ଭାଇଙ୍କ ଝି ଅ

B.  ମା'ଙ୍କ ଭଉଣୀ

C.  ଭଉଣୀ

D.  ଭାଇଙ୍କ ସ୍ତ୍ରୀ

✓

Q92 Reasoning
A, B, C, D, E, F ଓ G ଏକ ଗୋଲାକାର ଟେବୁ ଲ ଚାରି ପାଖରେ କେନ୍ଦ୍ରକୁ  ମୁ ହଁ  କରି  ବସି ଛନ୍ତି
। G ର ଠି କ ଡାହାଣ ପଟେ E ବସି ଛି  । E ର ବାମ ପଟକୁ  ତୃ ତୀୟ ସ୍ଥାନରେ A ବସି ଛି  । D
ହେଉଛି  A ଓ F ର ନି କଟତମ ପଡ଼ୋଶୀ । G ର ଠି କ ବାମ ପଟେ B ବସି ଛି  । D ର ଠି କ ବାମ
ପଟେ କି ଏ ବସି ଛି ?

A.  G

B.  B

C.  E

D.  F

✓

Q93 Reasoning
ସାତଟି  ବାକ୍ସ A, L, C, D, E, Y ଓ G କୁ  ଗୋଟି ଏ ଉପରେ ଗୋଟି ଏ କରି  ରଖାଯାଇଛି  କି ନ୍ତୁ
ସମାନ କ୍ର ମରେ ରଖି ବା ଜରୁ ରୀ ନୁ ହେଁ  । A ତଳେ କେବଳ ଦୁ ଇଟି  ବାକ୍ସ ରଖାଯାଇଛି  । ଶୀର୍ଷ ରୁ
ଚତୁ ର୍ଥ  ସ୍ଥାନରେ E କୁ  ରଖାଯାଇଛି  । L ର ଠି କ ତଳେ Y କୁ  ରଖାଯାଇଛି  । G ର ତଳେ କି ନ୍ତୁ E
ର ଉପରେ D କୁ  ରଖାଯାଇଛି  । G ଶୀର୍ଷ ତମ ବାକ୍ସ ନୁ ହେଁ  । ନି ମ୍ନ ରୁ  ପଞ୍ଚମ ସ୍ଥାନରେ କେଉଁ
ବାକ୍ସକୁ  ରଖାଯାଇଛି ?

A.  G

B.  D

C.  C

D.  L

✓

Q94 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ୍  ଭାଷାରେ 'CURB' କୁ  '7528' ଭାବରେ ଏବଂ 'CURE' କୁ  '3527'
ଭାବରେ କୋଡ୍  କରାଯାଇଛି  । ପ୍ର ଦତ୍ତ କୋଡ୍  ଭାଷାରେ 'E' ପାଇଁ  କୋଡ୍  କ'ଣ ହେବ?

A.  3

B.  8

C.  2

D.  5

✓

Q95 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ JTYU ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ RBGC ସହି ତ
ସମ୍ପର୍କିତ । PZEA ସେହି  ସମାନ ଉପାୟରେ XHMI ସହି ତ ସମ୍ପର୍କିତ । ସମାନ ତର୍କ
ଅନୁ ସାରେ ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସହି ତ NXCY ସମ୍ପର୍କିତ?

A.  VFKG

B.  VGHU

C.  VHGY

D.  VKIO

✓

Q96 Reasoning
ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମକୁ  ତର୍କ ସି ଦ୍ଧ ଭାବେ ସଂପୂ ର୍ଣ୍ଣ  କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ଅକ୍ଷର-ସଂଖ୍ୟା ପୁ ଞ୍ଜ
ମଧ୍ୟରୁ  କେଉଁ ଟି କୁ  ପ୍ର ଶ୍ନ ଚି ହ୍ନ (?) ସ୍ଥାନରେ ସ୍ଥାପି ତ କରାଯାଇପାରି ବ?
VAN97 , CHU84 , JOB71 , QVI58 , ?

A.  XCP45

B.  OCP45

C.  YCP45

D.  XCR45

✓

Q97 Reasoning
ଯଦି  'A' ର ଅର୍ଥ  '÷', 'B' ର ଅର୍ଥ  '×', 'C' ର ଅର୍ଥ  '+' ଏବଂ 'D' ର ଅର୍ଥ  ହୁ ଏ '-', ତେବେ
ନି ମ୍ନ ଲି ଖି ତ ସମୀକରଣରେ ପ୍ର ଶ୍ନ  ଚି ହ୍ନ '?' ସ୍ଥାନରେ କ'ଣ ହେବ?
15 B 5 D 70 A 2 C 12 D 5 B 2 = ?

A.  36

B.  30

C.  48

D.  42

✓

Q98 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ମଧ୍ୟରୁ  ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ
ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ତେଣୁ  ଏହି ପରି  ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି  । କେଉଁ ଟି  ସେହି
ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ  ?
(ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ  ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ )

A.  GIK

B.  HJM

C.  EGJ

D.  LNQ
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✓

Q99 Reasoning
ପ୍ର ଦତ୍ତ ବି ବୃ ତି  ଓ ନି ଷ୍କର୍ଷ ଗୁ ଡି କୁ  ଧ୍ୟାନର ସହି ତ ଅଧୟନ କରନ୍ତୁ । ସାଧାରଣ ଜଣାଶୁ ଣା ତଥ୍ୟ
ଠାରୁ  ଭି ନ୍ନ ବୋଲି  ପ୍ର ତୀତ ହେଲେ ମଧ୍ୟ ତୁ ମକୁ  ପ୍ର ଦତ୍ତ ବି ବୃ ତି  ଗୁ ଡ଼ି କୁ  ସତ୍ୟ ବୋଲି
ବି ବେଚନା କରି ବାକୁ  ହେବ ଏବଂ ପ୍ର ଦତ୍ତ ବି ବୃ ତି ରୁ  ତର୍କ ସି ଦ୍ଧ ଭାବରେ ଅନୁ ସୃ ତ ନି ଷ୍କର୍ଷ ଟି /
ଗୁ ଡ଼ି କ ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।

ବି ବୃ ତ୍ତି : କି ଛି  କାର୍ପେ ଟ ପଙ୍ଖା ଅଟେ । କୌଣସି  ପଙ୍ଖା ଗାଡ଼ି  ନୁ ହେଁ  ।

ନି ଷ୍କର୍ଷ  (I): କି ଛି  କାର୍ପେ ଟ ଗାଡ଼ି  ଅଟେ ।
ନି ଷ୍କର୍ଷ  (II): କି ଛି  ପଙ୍ଖା କାର୍ପେ ଟ ଅଟେ ।

A.  କେବଳ ନିଷ୍କର୍ଷ (I) ଅନୁ ସରଣ କରେ

B.  କେବଳ ନିଷ୍କର୍ଷ (II) ଅନୁ ସରଣ କରେ

C.  ନିଷ୍କର୍ଷ (I) କିମ୍ବା (II) ଅନୁ ସରଣ କରେ ନାହିଁ

D.  ଉଭୟ ନିଷ୍କର୍ଷ (I) ଏବଂ (II) ଅନୁ ସରଣ କରେ

✓

Q100 Reasoning
ଦି ଆଯାଇଥି ବା ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅ । ଗଣନା କେବଳ ବାମରୁ  ଡାହାଣକୁ
କରାଯି ବ ।

(ବାମ) S U P P E R I S T H E L A S T M E A L O F T H E D A Y T H A T
(ଡାହାଣ)

ଏପରି  କେତୋଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ  ଅଛି  ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ  ଅଛି
ଏବଂ ଠି କ ପରେ ଏକ ସ୍ୱରବର୍ଣ୍ଣ  ମଧ୍ୟ ଅଛି  ?

A.  ପାଞ୍ଚ

B.  ଚାରି

C.  ତି ନି

D.  କି ଛି  ନାହିଁ
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